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    Chapter 9   

 Bisulfi te Pyrosequencing 

           Christopher     F.     Bassil    ,     Zhiqing     Huang    , and     Susan     K.     Murphy    

    Abstract 

   Bisulfi te pyrosequencing is a sequencing-by-synthesis method used to quantitatively determine the 
methylation of individual CG cytosines from PCR amplicons of a region up to 115 bases in length. The 
procedure relies on prior bisulfi te conversion of all potentially methylated CG cytosines to either cytosine 
(methylated) or thymine (unmethylated) and involves the stepwise incorporation of deoxynucleotide tri-
phosphates into the growing strand of nascent DNA. The incorporation of these dNTPs results in the 
proportional release of pyrophosphate, which is converted into ATP to aid in a subsequent conversion of 
luciferin to oxyluciferin. The amount of light released in the process is proportional to the number of 
nucleotides incorporated, and the procedure provides a quantitative portrait of the methylation profi le for 
the amplicon in question.  

  Key words     PCR  ,   Pyrosequencing  ,   Sequencing-by-synthesis  ,   Methylation  ,   Epigenetics  

1       Introduction 

 Pyrosequencing is a sequencing-by-synthesis method used to 
quantitatively determine the methylation of individual CG cytosines 
from PCR amplicons produced using a bisulfi te-modifi ed DNA 
template. The pyrosequencing approach involves isolating the 
template strand from its complementary strand following PCR 
amplifi cation, accomplished as a result of incorporation of biotin 
at the 5′ end of the primer used to initiate amplifi cation of the 
particular strand destined to undergo pyrosequencing. Following 
PCR amplifi cation, the biotin-labeled double-stranded PCR ampli-
con is bound to streptavidin beads that are then immobilized on 
vacuum fi ltration tips that allow for removal of the complementary 
(non-biotin containing) strand through denaturation and purifi ca-
tion. The single-stranded DNA is then annealed to a sequencing 
primer and undergoes pyrosequencing, allowing for the incorpora-
tion of deoxynucleotide triphosphates (dNTPs), one at a time, in a 
template-dependent, stepwise fashion. 
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  Fig. 1    Bisulfi te pyrosequencing. The pyrosequencing reaction uses a single-
stranded, biotin-labeled template and involves the addition of a single nucleotide 
at a time into the reaction mix. Following incorporation of the nucleotide into the 
nascent complementary strand by DNA polymerase, pyrophosphate is released 
in a stoichiometric manner and is used to form ATP by ATP sulfurylase. The ATP 
then fuels production of oxyluciferin from luciferin by luciferase, whereby light is 
emitted that is proportional to the amount of ATP produced and thus to the num-
ber of nucleotides incorporated. The pyrosequencing instrument measures the 
light produced and plots this on a graph called a pyrogram. Any unincorporated 
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 As each nucleotide is incorporated by the polymerase into the 
growing strand, pyrophosphate is released. The pyrophosphate is then 
converted to ATP by ATP sulfurylase and serves as fuel for the 
 luciferase-mediated conversion of luciferin to oxyluciferin, which 
releases visible light that is proportional to the amount of pyrophos-
phate initially released and thus to the number of nucleotides incorpo-
rated (Fig.  1 ). Any residual unincorporated nucleotides that remain in 
the reaction mixture are degraded after each step by apyrase. 
The intensity of the light emitted for each reaction well is used to 
both provide information regarding the quantity of template pres-
ent and also to confi rm that the sequence produced matches the 
sequence of the template. Cytosines that are potentially methyl-
ated are treated as variable positions in the sequence, whereby 
sequential addition of bases corresponding to methylated (C) and 
unmethylated (T) cytosines provides the means to quantify meth-
ylation by measuring peak heights refl ecting the incorporation of 
cytosine relative to the total incorporation for cytosine plus thy-
mine at that particular position. These percentages are automati-
cally calculated by the PyroMark® CpG Software for each of the 
CG cytosines within the sequence analyzed. 

  Over 84,000 predesigned pyrosequencing assays are available 
for purchase through Qiagen (PyroMark® CpG Assays;   www. 
qiagen.com    ). Alternatively, pyrosequencing assays can be designed 
using PyroMark® Assay Design Software (Qiagen; Valencia, USA). 
A thorough description of assay design is beyond the scope of this 
chapter, but in our experience there are several critical factors to 
achieve success. The pyrosequencing reaction is carried out at a 
relatively low temperature and as such is vulnerable to mispriming 
events from promiscuous priming of the sequencing primer but 
also potentially from carry forward of any unincorporated biotin- 
tagged primer or even from template looping. The PyroMark® 
Assay Design Software detects and evaluates these potential 
mispriming events. This information is used as part of the criteria 
for determining the suitability of the assay design. Pyrosequencing 

Fig. 1 (continued) nucleotides are degraded by apyrase (not shown) prior to 
injection of the next nucleotide in to the reaction mix. The  y  axis of the pyrogram 
represents the light produced and the  x  axis provides a readout of the sequence 
to analyze. Note that multiple sequential same nucleotides in the template will 
result in incorporation of a proportional amount of the complementary nucleotide 
at one pyrogram peak position, such that two of the same nucleotides in a row 
will produce a peak height that is twice as big as that for a single nucleotide 
incorporation, and so on. The % methylation measured for each CG cytosine is 
shown above the pyrogram and is calculated by the software. The single nucleo-
tide width vertical shading at nucleotide position 13 indicates a bisulfi te control 
representing a non-CG cytosine in the original sequence. “E” represents injection 
of enzyme at the beginning of the run, “S” indicates the injection of substrate, 
both of which should not produce measurable light       
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using current technology is limited to no more than ~115 bp in 
length. PCR amplicons for pyrosequencing should be between 
150 and 250 bp in length to avoid potential amplifi cation bias and 
to minimize potential for mispriming [ 1 ]. 

 We use Qiagen’s Epitect Control DNAs for pyrosequencing 
assay validation prior to use in evaluating methylation in research 
specimens by preparing and running replicates of defi ned mixtures 
of the fully methylated and unmethylated DNAs as follows: 100%U, 
25%M:75%U, 50%M:50%U, 75%M:25%U, and 100%M. This 
allows us to determine the degree of technical variability, to detect 
the potential bias in amplifi cation of the methylated versus unmeth-
ylated sequence, and to ensure that the assay is able to detect a 
linear increase in methylation across the dynamic range of the assay. 

 There are multiple procedural steps required for pyrosequencing, 
and as such Subheading  3  is broken into subsections that describe 
the PCR reaction, setting up the pyrosequencing run, procedures 
for preparing the reagent and capillary tips, preparing the master mix 
and primer, preparing the nucleotides, preparing the PCR product 
and adding nucleotides to the tips, performing the dispensation 
test and preparing the workstation, loading the plate and beginning 
the run, workstation cleanup, and data analysis and interpretation. 

 Bisulfi te pyrosequencing is particularly useful for not only 
detailed and accurate quantitative analysis of methylation at specifi c 
loci but also analysis of repeat elements, often used as a proxy to 
assess how methylation is altered throughout the genome. Once 
assay conditions are optimized, pyrosequencing is amenable to 
high-throughput analysis of many specimens since the assays are 
carried out in 48-well or 96-well plate format. We have shown that 
pyrosequencing can distinguish 5 % differences in methylation 
using defi ned mixtures of methylated and unmethylated template 
DNAs [ 2 ]. Pyrosequencing has been used to evaluate DNA meth-
ylation profi les in multiple studies of cancer, including gynecologic 
malignancies [ 3 – 6 ].  

2     Materials 

      1.    PyroMark ®  PCR Kit containing 2× PyroMark ®  PCR Master 
Mix, 10× CoralLoad™ Concentrate, 25 mM MgCl 2  stock, and 
Nuclease-free water.   

   2.    PCR Primers (one with 5′ biotin label, HPLC purifi ed; 
 see  Subsection  3.1 , PCR, below).   

   3.    96-well plate.   
   4.    Nuclease-free H 2 O.   
   5.    PyroMark ®  Binding Buffer.   
   6.    PyroMark ®  Annealing Buffer.   

2.1  Reagents 
and Supplies
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   7.    GE Healthcare Streptavidin Sepharose™ High-Performance 
Beads.   

   8.    Pyrosequencing Primer.   
   9.    PyroMark ®  Gold Q96 CDT Reagents including PyroMark ®  

Enzyme Mixture, PyroMark ®  Substrate Mixture, and 
PyroMark ®  dNTPs (dATPαs, dCTP, dGTP, and dTTP).   

   10.    Plate Sealing Film for Raised Edge Plates (Denville Scientifi c, 
Inc.).   

   11.    PyroMark ®  Wash Buffer, 10×.   
   12.    PyroMark ®  Denaturation Solution.   
   13.    PyroMark ®  Q96 HS Plate.   
   14.    PyroMark ®  Q96 HS Capillary Tips (CDTs).   
   15.    PyroMark ®  Q96 HS Reagent Tips (RDTs).   
   16.    Aluminum Plate Seals (Greiner Bio-One SILVERseal).      

      1.    PyroMark ®  Q96 MD Pyrosequencing Instrument.   
   2.    PyroMark ®  Q96 Vacuum Workstation.   
   3.    96-well Capacity Thermocycler.   
   4.    Eppendorf MixMate plate mixer ( see   Note 1 ).   
   5.    Heat block, prewarmed to 85 °C.       

3      Methods 

   PCR for pyrosequencing requires use of a forward and reverse 
primer, one of which is modifi ed by the addition of a biotin molecule 
at the 5′ end. The primer containing the biotin molecule should 
be the one used to synthesize the strand that will be used as tem-
plate for pyrosequencing. Without the biotin, the amplifi ed DNA 
will not be retained on the streptavidin beads for analysis in later 
steps and will instead pass through the fi lter probes of the pyrose-
quencing workstation. Optimization of PCR conditions for the 
primers is required prior to their use in pyrosequencing. The goal of 
the optimization is to produce a single, robust band of the correct 
size as detected by ethidium bromide staining following agarose 
gene electrophoresis. Due to the added expense of the biotin 
modifi cation of the primer, we typically order standard primers for 
use during the PCR optimization process. Once the optimal PCR 
conditions are defi ned, we order the appropriate primer with the 5′ 
biotin modifi cation and with HPLC purifi cation.

    1.    Prepare the PCR Master Mix in a nuclease-free tube to bring 
the volume per reaction to 25 μL after the addition of bisulfi te 
modifi ed DNA in  step 2  ( see  Table  1  and  Note 2) .

2.2   Equipment

3.1    PCR

Bisulfi te Pyrosequencing
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       2.    Add bisulfi te modifi ed DNA (20–50 ng) to the PCR master 
mixture in each reaction well. After sealing the tube, vortex, 
and quick spin to collect contents at the bottom of tubes.   

   3.    Transfer the reaction wells to a thermocycler and perform PCR 
using the conditions most appropriate for an analysis of the 
gene in question.   

   4.    After the PCR has fi nished, the sample may either be removed 
from the thermocycler for immediate analysis or stored at -20 °C.      

        1.    Open PyroMark ®  CpG Software 1.0.11.   
   2.    For a new assay, open a new fi le in Pyro Q-CpG design folder, 

right click and choose “New Assay.” Copy/paste the sequence 
into the “sequence to analyze” window and click on “generate 
dispensation order.” Add bisulfi te control sites at the orange 
“T” sites as designated by the software, which are preselected as 
bisulfi te controls and represent non-CG cytosines in the original 
sequence. The CG sites are highlighted in gray and the BS con-
trol sites are in orange.   

   3.    Select “File → New Run” to access the run setup menu. The run 
setup menu can also be accessed by clicking on the “New Run” 
icon located beneath the toolbar.   

   4.    There will be three smaller run setup windows that appear on 
the right of the screen. The upper left screen shows the run 
name, instrument parameters, plate ID, reagent ID and also 
has a small window available for entering notes.   

   5.    Enter run name and plate ID in the run setup menu.   
   6.    Select “Instrument Parameters” according to the CDT version 

used. The parameter information for specifi c CDT versions 

3.2  Pyrosequencing: 
Setting Up the Run

   Table 1  
  PCR Master Mix   

 Stock 
 Reaction mix 
volumes (μL)  Final concentration 

 Reverse primer  0.3 μL  120 nM 

 Forward primer  0.3 μL  120 nM 

 25 mM MgCl 2   1.5 μL  1.5 μM 

 10× Coral Load™ Concentrate  2.5 μL  1× 

 2× PyroMark ®  PCR Master Mix  12.5 μL  1× 

 DNA (to be add later)   X   20–50 ng/reaction 

 Nuclease-free water   X  

 Total volume  25 μL 
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can be found at   www.qiagen.com     and is based on the lot 
number of the CDTs purchased.   

   7.    The lower panel on the right-hand side of the screen shows the 
plate wells. There are three text boxes for each well. The upper-
most text box is used to designate which assay you want to run, 
selected from the pre-entered assay designs. Select the appropri-
ate assay in the Pyro Q-CpG design folder and drag and drop 
this on the “Assay Name” in the top text box of the fi rst well. 
Click the box and drag the cursor across all other wells to assign 
that same assay information via auto-fi ll, as appropriate.   

   8.    Enter the sample ID into the middle textbox of each well in 
the “Plate Wells” panel. The lower text box can be used for 
adding any desired notes.   

   9.    After all of the above information has been entered, the right 
upper panel will show the well information with the assay 
design, sample ID, and notes. Double check to ensure that all 
information is correct.   

   10.    For reagent and capillary tip volume information, select 
“Tools → Volume Information.” Enzyme and substrate vol-
umes are listed under “E-mix” and “S-mix”, respectively. 
Nucleotide volumes for capillary tips are listed according to 
each base. Note these volumes for a later step in the protocol.      

  Cleaning of the reagent and capillary tips should be performed 
both prior to and after a run ( see   Note 3 ).

    1.    To wash a reagent (RDT) or capillary (CDT) tip, fi rst rinse the 
interior of the tip with nuclease-free water fi ve times by fi lling 
to the brim with nuclease-free water and inverting to empty.   

   2.    After the tip has been rinsed, fi nish cleaning by “milking” fi ve 
times. To milk the tip, fi rst fi ll to the brim with nuclease-free 
water and then create a seal at the top by completely covering 
the opening with your thumb. Then, lightly apply pressure 
to the top and sides of the tip using the thumb and forefi ngers 
of the opposite hand, respectively, until a straight stream of 
water can be steadily produced.   

   3.    Once tips have been rinsed and milked prior to use in the pyro-
sequencing run, place each tip upside down on a Kim wipe 
until use.    

        1.    To prepare the master mix, in a 15-mL conical tube combine 
2 μL of Sepharose streptavidin-coated beads, 40 μL of 
PyroMark ®  Binding Buffer, and nuclease-free water to bring 
the volume to 80 μL for each of the reactions after accounting 
for addition of the PCR product (plus some additional to allow 
for pipetting error) ( see   Note 4 ).   

   2.    Invert gently several times to mix (do not vortex).   

3.3  Cleaning Reagent 
and Capillary Tips

3.4  Preparing the 
PCR Components

Bisulfi te Pyrosequencing
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   3.    Immediately (before the beads settle) pipet the appropriate 
amount of master mix into each well of a PCR plate for each 
sample to be analyzed (80 μL minus the amount of PCR 
product to be added). Place on ice.   

   4.    To dilute the primer for an entire 96-well plate, add 4 μL of 
appropriate sequencing primer (100 μM) to 1,196 μL of 
PyroMark ®  Annealing Buffer and vortex thoroughly. Place on ice.   

   5.    In four separate tubes, prepare each of the four PyroMark ®  
dNTPs by mixing each dNTP with an equal volume of TE 
Buffer to make a fi nal volume given by “Tools → Volume 
Information” ( see   step 10  from Subheading  3.2 ).   

   6.    Add PCR product (8–10 μL) to the master mix in each well 
(from  step 3 , Subheading  3.4 ).   

   7.    Seal the plate thoroughly using an aluminum plate seal.   
   8.    Place the plate on the plate mixer at 1,400 rpm for 7–10 min at 

room temperature.   
   9.    Load each dNTP mixture into the corresponding CDT in alpha-

betical order (A, C, G, T). Load the required volumes of enzyme 
and substrate into the RDT tips. Place each CDT and RDT tip 
into its corresponding slot in the cartridge ( see   Note 4 ).      

      1.    To insure proper functioning of the tips, a dispensation test, 
controlled by the software, is performed prior to the actual run 
whereby reagents and nucleotides are dispensed by the pyrose-
quencer onto a clear plastic plate cover and should form droplets 
that are easily visible and of uniform size. Open the outer lid 
of the PyroMark ®  Q96 MD. Load the reagent cartridge into 
the instrument and select “Open Process Chamber” from the 
software menu. Once the process chamber is open, load a dis-
pensation test plate with a clear plastic cover on top and click 
on “Close Process Chamber.” Then, click on “Test Dispensing 
Tips” to begin the dispensation test.   

   2.    To prepare the workstation, load troughs 1–4 with 110 mL 
70 % EtOH, 90 mL PyroMark ®  Denaturation Solution, 
110 mL nuclease-free water, and 110 mL PyroMark ®  Wash 
Buffer, respectively. Load the “Parking” trough with 180 mL 
nuclease-free water and submerge the fi lter tips of the vacuum 
prep tool in the nuclease-free water.   

   3.    Return to the computer, close the “Test Dispensing Tips 
Finished” message, and open the process chamber lid. The dis-
pensations should appear as six rounded droplets. If any of the 
droplets are not present or appear aberrant, repeat the dispen-
sation test. If the problem persists after multiple dispensation 
tests, rinse tips and test for fl ow-through of liquid using the 
manual cleaning procedure described above in “Cleaning 
Reagent and Capillary Tips.”   

3.5  Dispensation 
Test and Preparing 
the Pyrosequencing 
Reactions
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   4.    Vortex the diluted primer and add 12 μL to each well in a 
PyroMark ®  Q96 plate. Once the primer has been plated, slide 
the PyroMark ®  Q96 plate into the PyroMark ®  plate platform in 
the vacuum workstation.   

   5.    Remove the plate with the PCR product from the vortexer and 
peel off the aluminum seal. DO NOT quick spin the PCR 
product plate at this point. Then, check to make sure that the 
vacuum seal on the liquid waste container at the workstation is 
tightly sealed.   

   6.    Remove the prep tool from the parking trough and start the 
pump. Apply a vacuum to the prep tool by turning the worksta-
tion to ON. Keep the vacuum ON THROUGH  step 9  so that 
the beads remain attached to the fi lter probes. Matching posi-
tion A1 of the prep tool to position A1 of the PCR product-
beads plate, slowly lower the fi lter probes into the plate wells 
until the entire PCR product mixture has been aspirated through 
the fi lter tips and the streptavidin beads have been immobilized 
on the probes. Then, gently remove the prep tool from the 
plate, taking care not to dislodge the streptavidin beads from 
the fi lter probes. Aspiration of the liquid and immobilization of 
the beads on the fi lter probes should take roughly 15 s.   

   7.    While maintaining the vacuum, place the prep tool fi lter probes 
directly into the 110 ml of 70 % EtOH in trough 1. Once fl uid 
is visible in the tubing, continue aspiration for 5 s, then remove 
the prep tool from the 70 % EtOH while maintaining its orien-
tation and allow the remaining 70 % EtOH to be fully aspi-
rated from the prep tool by the vacuum.   

   8.    Place the prep tool into the 90 mL of PyroMark ®  Denaturation 
Solution in trough 2. Once fl uid is visible in the tubing, con-
tinue aspiration for 5 s, remove the prep tool and allow the 
Denaturation Solution to be fully aspirated from the prep tool 
by the vacuum.   

   9.    Place the prep tool into the 110 mL of PyroMark ®  Wash Buffer 
in trough 3 and aspirate the Wash Buffer completely. Lift the 
prep tool out of the Wash Buffer and, while maintaining its 
orientation, turn the workstation to OFF, stop the pump, and 
release the vacuum on the liquid waste container by loosening 
the lid.   

   10.    Lower the prep tool into the primer-loaded PyroMark ®  Q96 
plate in the plate platform of the workstation, so that the fi lter 
probes rest in their corresponding wells (A1 to A1). Gently 
rock the prep tool from side to side to release the beads into 
the wells.   

   11.    Place the PyroMark ®  Q96 plate on a prewarmed PyroMark ®  
Q96 Sample Prep Thermoplate. There are two parts to the 
Thermoplate; the PyroMark ®  Q96 plate should be sandwiched 
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between the upper and lower blocks and should be fully 
 covered by the top block. Place the PyroMark ®  Q96 plate- 
Thermoplate onto the surface of the heating block at 85 °C for 
2 min.   

   12.    After 2 min, switch the heating block off but do not remove 
the PyroMark ®  Q96 plate-Thermoplate from the heating 
block. Allow the PyroMark ®  Q96 plate-Thermoplate to sit 
atop the (now cooling) heating block for another 2 min. Then, 
remove the PyroMark ®  Q96 plate from between the two blocks 
of the Thermoplate and let cool to room temperature (~5 min). 
Once the PyroMark ®  Q96 plate has reached room tempera-
ture, move on to the next part of the protocol.      

      1.    Click on “Open Process Chamber” and insert the PyroMark ®  
Q96 plate into the PyroMark ®  Q96 MD instrument, and select 
“Close Process Chamber.”   

   2.    Begin the run by clicking the “Start Run” arrow button located 
next to the run parameters.      

      1.    Place the fi lter probes of the prep tool into the 110 mL of 
nuclease-free water in trough 4 and gently agitate for 10 s.   

   2.    Tighten the vacuum lid on the waste container, start the pump, 
and turn the workstation to ON to flush the filter probes 
for ~5 s.   

   3.    Lift the prep tool from the water, and aspirate the water 
through the prep tool.   

   4.    Stop the pump, turn the workstation to OFF, release the vac-
uum and return the prep tool into a clean storage box until 
next use ( see   Note 5 ).      

      1.    When the run is complete, the data for each sample will be 
analyzed by the software and scored as “passed,” “check quality,” 
or “fail.”   

   2.    Run data for each specimen should be inspected to insure that 
adequate peak heights were achieved (~150–300 light units for 
a single-nucleotide incorporation). Low peak heights are more 
likely to refl ect stochastic results from having too little tem-
plate or loss of beads during the wash steps on the workstation, 
even if the run was scored as “passed.”   

   3.    The pyrogram software output produced for each sample 
provides a linear representation of the sequence read based on 
the intensity of light produced after each incorporation. Peak 
heights will proportionately increase with the number of same 
sequential nucleotides in the template being sequenced. For 
example, the template sequence 3′-A-G-G-T-T-T-A-T-5′ will 
show results in which the fi rst incorporation will be a single 

3.6  Loading 
the Plate and 
Beginning the Run

3.7  Workstation 
Cleanup

3.8  Data Analysis 
and Interpretation
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peak height T, the second will be a double peak height C, the 
third will be a triple peak height A, the fourth will be a single 
peak height T, and the fi fth will be a single peak height A. 
Deviations in the expected peak heights, based on those antici-
pated from the input sequence, will trigger the software to 
score the run as a “check quality” run or a “fail.”   

   4.    The pyrosequencing software treats cytosines within “CG” 
dinucleotide positions within the sequence much like a poly-
morphic site, since either a C or T is possible at the cytosine 
position depending on if this particular cytosine was methylated 
or unmethylated, respectively, in the original sequence. Thus, 
the sequence to analyze will contain a “T” adjacent to a “C”. 
The light produced from each of these peaks is used to deter-
mine the proportion of cytosine that is methylated in the sam-
ple at that position by calculating the light intensity produced 
from incorporation of the C relative to the total produced from 
combined C + T incorporation. The percent methylation calcu-
lated is provided as a visual readout above each CG position 
within the sequence in the pyrogram.   

   5.    Bisulfi te controls are also a necessary component of pyrose-
quencing and are automatically chosen and inserted into the 
sequence to analyze by the PyroMark ®  CpG Software. These 
controls represent cytosines in the original sequence that are not 
in CG context and therefore should be fully converted by the 
bisulfi te treatment to uracils (thymine following PCR). A “T” 
adjacent to a “C” is also used for these positions, just as for CG 
cytosines (described above), except in this case the results should 
show near complete incorporation for the “T”. The proportion 
of “C” incorporation at these positions is indicative of the degree 
to which conversion was incomplete, at least at that position. 
This is calculated by the software, which has a default threshold 
setting of 96.5 % conversion (4.5 % incomplete conversion of 
cytosines) before a sample will fail the run. This threshold set-
ting can be adjusted using the software settings as desired. It is 
important to note that incomplete conversion will falsely elevate 
the signals coming from CG positions. In our hands, conversion 
effi ciencies are typically >98 % for high quality, high purity bisul-
fi te modifi ed genomic DNA.       

4     Notes 

     1.    It is important to use a mixer that can thoroughly mix the 
reagents in a 96-well plate while not causing the reagents to 
spill or splash up onto the sides of the tubes or the plate seal. 
We have tried several brands and the Eppendorf MixMate 
works well in our hands.   
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   2.    It is strongly recommended to include controls on each plate 
for both the PCR reactions (e.g., positive control, no template 
control, etc.) and pyrosequencing reactions (annealing buffer 
plus template but without primer, primer plus annealing buffer 
but without template) along with positive and negative con-
trols for methylation status. We use the EpiTect Control DNAs 
from Qiagen that are provided in bisulfi te modifi ed form. 
These are produced using whole genome amplifi cation fol-
lowed by treatment with or without the bacterial  Sss I methyl-
transferase.  Sss I methyltransferase enzymatically methylates all 
CG cytosines throughout the genome to generate the fully 
methylated DNA while the methylation pattern in the original 
template is effectively “erased” by the whole genome amplifi -
cation to produce the unmethylated DNA. These controls are 
especially useful for assessing assay performance for regions of 
the genome that normally exhibit endogenous methylation, 
such as imprinted loci, since it is extremely diffi cult to obtain 
naturally occurring DNA specimens that exhibit a complete 
lack of methylation at these loci for use as unmethylated 
controls.   

   3.    It is critical to clean the tips well, as unexpected peaks might 
otherwise be generated in the subsequent sequencing run. 
These unexpected peaks can be caused by pyrophosphate gen-
erated as a result of reagent(s) remaining in unclean tips. We 
have found that with appropriate handling, CDTs can be 
cleaned and reused for up to 15 runs and RDTs for up to 
8 runs.   

   4.    Due to light sensitivity, minimize exposure of the reagents to 
light.   

   5.    An empty pipet-tip box can be used as a storage box such that 
the fi lter probes are gently inserted into the empty holes and 
thus kept clean and protected from damage.         
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